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INTRODUCTION

What is jBrout ?

jBrout is a JPEG (format widely used by digital cameras) picture manager software, 
written in python/pygtk under the GPL licence. It can be run on multiple platforms, 
and  the  current  version  has  been  tested  under  GNU/Linux  and  Windows  XP/2k 
environments.

jbrout maybe localized (currently in French and English version).

jbrout can manage an unlimited number of pictures.

jBrout   can:  

• manage albums (folders) and pictures in JPEG format,
• create folders by dates,
• tag pictures with IPTC keywords (tags),
• add comments to pictures (into the JPEG comment field) and albums (text file 

in the album folder),
• rotate loss-less JPEG (and internal JPEG thumbnail),
• display the picture EXIF fields (date, size,shooting),
• search pictures by tag, comment, date and format,
• use plugins,
• call externals tools (for example open picture with Gimp),
• export pictures (to a Web gallery in HTML format, perform like a HTTP server, 

send by email,...),
• export to a Flickr or PicasaWeb account,
• use a basket system to pick out pictures.

jBrout   cannot yet:  

• manage pictures in formats other than JPEG.
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How jBrout manages your pictures ?

• jBrout doesn't use a database (proprietary or not) to file your pictures and save 
the thumbnails pictures. The pictures albums are simply managed through your 
own folders.

• The fact is jBrout uses two XML files to file your pictures and speed up displays 
and searches. These two files can be rebuilt at any time when reimporting your 
pictures.  Their  content  is  exclusively  based  on  the  data  coming  with  your 
pictures.

• All the information managed by jBrout is stored in your pictures: 
• keywords (tags) in the IPTC data,
• dates in the EXIF data,
• comments in the comment JPEG field,
• thumbnails in the internal thumbnail of the EXIF data.

• This principle guarantees the continuity of the pictures data and abides by the 
EXIF and IPTC norms.

• jBrout respects  your pictures.  It  doesn't  modify any essential  information in 
them.  In  order  to  respect  norms,  jBrout  uses  well-known  tools  (jhead, 
jpegtran/exiftran,...).

• The comment associated with an album is saved as a text file in the album 
folder.

Acknowledgements

To Marc LENTZ, the designer, without whom jBrout would not exist,

to Frederic PETERS, for his invaluable developments (especially the listview),

to Erik CHARLESSON, for the on-line help and this manual,

and for all jBrout's users...
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INSTALLATION

under GNU/Linux

Debian/Ubuntu:

• Add this repository with synaptic:

• Type: Binary
• URL: http://jbrout.free.fr/download/debian
• Distribution: binary/

• Install jbrout from synaptic

Distributions RPM:

• Download and install the rpm package (you must also install python2.4 lxml 
package. Follow this link).

from SVN sources:

The SVN sources often offers a most recent version of jBrout. This is a simple way to 
install jBrout in Linux distributions not listed above.

• If necessary, install SVN (subversion).
• If necessary, delete the old sources installed by synaptic:

• rm -r /usr/lib/jbrout
• Install sources:

• svn co http://svn.jbrout.python-hosting.com/trunk /usr/lib/jbrout
• Add an entry in your menu.
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Under Windows XP/2K

Before installation:

• Install the GTK+ runtime environment: Download the installation process from 
this link, then run it.

Installation:

• Download the most recent package win32 of jBrout (content sources, pygtk, 
python, lxml, PIL,...) from this link , then decompress it in “c:\Program Files”. It 
creates a sub-folder named jbrout.

Running:

• In the “c:\Program Files\jbrout” folder, run jbrout.bat (double-click on it). You 
may also create a short cut on your desktop.

From SVN sources (subversion):

the SVN sources often offers a most recent version of jBrout.

• Install TortoiseSVN from this link.
• Reboot Windows.
• Open your files browser and select the “c:\Program Files\jbrout” folder. 

First time:

• Right-click on the “App” folder and click on the “SVN Extract...” option. Inform 
in the dialogue window witch open:

• Referential URL: http://svn.jbrout.python-hosting.com/trunk
• Extract folder: c:\Program Files\jbrout\App

• Valid. The sources update begin.

following times:

• Right-click  on  the  “App”  folder  and  click  on  the  “SVN update”  option.  The 
sources update begin.
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Installing the EXIFutils tools:

To  optimize  the  rebuilding  of  the  thumbnails,  you  can  install  the  more  powerful 
EXIFutils shareware. It's not included in jBrout because it's not under free licence LPG. 
But independently, it's recommended to install it:

• Download the Windows full version from http://www.hugsan.com/EXIFutils/
• launch the installation:

• Destination folder: “C:\Program Files\jbrout\App\tools”.
• In option, don't notch “Documentation (PDF format)”.

• A the end of installation, it's not necessary to reboot Windows.

Manual_jBrout_0.2.182 8 / 34

http://www.hugsan.com/EXIFutils/
http://www.hugsan.com/EXIFutils/
http://www.hugsan.com/EXIFutils/


Managing your pictures with jBrout 2007-06-29

FIRST UTILISATION

Before starting

JBrout can rename your pictures while importing them. When jBrout is run for the first 
time, you’re asked the following question:

It is strongly advised to answer “yes”. Afterwards, when importing every new batch of 
pictures, jBrout will rename them using the date and time stored in the EXIF data of 
each picture.

Principle:

• Each  picture  is  renamed  as  “pAAAAMMJJ-hhmmss.jpg”  (ex: 
p20060601_105645.jpg).

• A picture with no valid EXIF date is not renamed.
• Technically, jBrout always tries to do: Date in the name of the file (if rename 

was chosen) = Modification date of the file = Internal EXIF date of the picture.

Pros:

• The shooting date is kept in the name of the picture. It is a precaution measure 
if  the  internal  EXIF  date  and  the  modification  date  of  the  file  on  the  disk 
happened to be changed by accident (by a non abiding program for example),

• In case of duplicated pictures, that makes their finding easier (same names but 
the  suffixes  “a”  on  the  first  photo  and  “b”  on  the  second  one,...:  example 
p20060601_105645a.jpg and p20060601_105645b.jpg),

• Your pictures are displayed sorted by dates in your file browser.

Cons:

• If you already have many pictures with meaningful names you want to keep,
• Or if you’re really keen on keeping the original names of your pictures.
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Comment: The choice of the automatic renaming or not of your pictures by jBrout is 
final.  In  either  case,  this  has no incidence  on  performances  and functionalities  in 
jBrout. It's just a usual way to name your pictures.

User interface presentation

JBrout  provides  a  simple  and  intuitive  interface.  Everything  is  done  by 
copy/move/paste or by using the contextual menu.

The “File” menu

“Find” option:

Opens  the  window to  perform an  advanced  pictures  search.  See  the  “Search  for 
photos” chapter for more details.

“Edit external tools” option:

Allows to edit the file tools.txt containing the calls to external tools (for example the 
launch of an editing picture application). See chapter “Call externals tools” for more 
details.

“Quit” option:

Exit the application.
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The “Display” menu

Allows to chose the order-by display criterion for thumbnails. Possible criteria are:

• tags,
• comment,
• album,
• date,
• name (default).

Thumbnails are always displayed in descending order. For example, with a sort by 
dates, the more recent pictures will be displayed at the beginning of the list.

The “Help” menu

“Help” option:

Opens jBrout on-line help in your browser.

“About” option:

Displays jBrout current version. The information is also displayed in the title bar.

The toolbox

Adds a new album.

Opens the window for advanced pictures search.

Rotates anti-clockwise the selected pictures.

Rotates clockwise the selected pictures.

Adjust the thumbnails sizes in the display list.

Display the tags and albums of the pictures displayed in the list.
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The navigation tabs

“Albums” tab:

Displays your albums list.  An album is a folder from your files system. With each 
album is also displayed the number of pictures it contains.

The list displays your albums tree; it  is sorted by ascending order on the albums 
names.

When an album is selected (with a double-click), its pictures and those belonging to 
its sub-albums are displayed.

“Time” tab:

For  the selected month,  lists  the  days in  which there is  at  least  one picture and 
displays the thumbnail of the first picture of these days.

Selecting a day (with a double-click) displays the corresponding pictures.

“Tags” tab:

Displays the list of categories and tags (keywords). Selecting a tag (with double-click) 
displays the pictures containing this tag.
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The pictures view

Pictures are displayed in thumbnail form. For this purpose, jBrout uses the pictures 
internal EXIF thumbnails.

If necessary, JBrout displays additional information according to the following:

JBrout is loading the thumbnail. it’ll be displayed soon.

 
The picture doesn’t seem to contain an EXIF thumbnail. Try to rebuild it 
through the contextual menu.

 
The picture EXIF format is wrong.

The picture is in jBrout database, but is not any longer on your disk. 

The picture contains wrong EXIF data.

The  icon shows that the picture is in read-only mode and cannot be 
modified.

The  icon shows that the picture has been put in the basket.
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MANAGING YOUR PICTURES

Managing your albums

Adding an album

Clicking on the  button in the toolbar opens the selection window. Select the folder 
containing  the  pictures  to  import  and  validate.  jBrout  creates  a  new  album and 
imports your pictures (while renaming them if you’ve chosen this functionality).

If the pictures already have tags, jBrout automatically adds in its database the new 
tags that don't already exist.

To record a comment for the album, double-click on the album. A capture field opens 
above the thumbnails to allow the comment to be capture.

Managing the albums

Select the “Albums” tab. A right click on the album gives access to the operations.

Display the pictures of an album:

Right-click on “Only this” option or Double-click on the album.

Rename an album:

Changes the name of the album and therefore the name of the folder on the disk.

New   album:  

Create a new album (empty) and therefore a new folder on the disk.

Refresh:

Reimports all the pictures of the album in jBrout.

Remove from db:

Removes the album from jBrout. The folder on the disk and the pictures within are not 
affected.
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Delete from disk:

Deletes the folder and the pictures within from the disk and remove the album from 
jBrout. You’ll be asked to confirm the operation.
Caution, the album deletion is final and cannot be undone!

Operations > Open in explorer:

Opens the folder of the album in the files browser.

Operations > Create folder by dates:

Creates as many folders as there are different dates in the pictures of the album, then 
moves the pictures by dates in these new folders.  The new folders are named as 
“Day_AAAAMMJJ”.
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Selecting pictures in the list

Click on a thumbnail to select a picture. To select others, press and hold the CTRL key 
while clicking on the pictures to be selected.

You also can use the wheel click of your mouse to select (or deselect) several pictures.

To select adjacent pictures, select the first picture of the group, then while holding 
down the SHIFT key, click on the last picture of the group.

To select all the pictures of the list, press and hold the CTRL key, and press the A key.
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Using tags

What is a tag ?

Tags  (or  keywords)  are  used  to  supplement  information  to  your  pictures  (place, 
people,  events,...),  in  order  to  classify  them and  make  searches  among  pictures 
easier. It is especially interesting when you have a lot of pictures.

JBrout stores the tags in the IPTC fields of your pictures.  This avoids any loss of 
information (except the loss of the picture itself !). Further more, people you share 
pictures with (mail, Web, CD, DVD,...), will have access to your tags.

JBrout organizes your tags by category. For example, your tags relating to places can 
be grouped together in a category named “Places”. Categories are never stored in 
your pictures. They exist only to let you better organize your tags in jBrout.

It’s up to you to find an adequate balance between the completeness brought by the 
tags information and a reasonable number of tags. Not enough tags in a picture will 
not describe it  enough, while too big a number will  generate to much work when 
tagging your future pictures.

There  is  no  predefined  rule.  The  following  example  suggests  an  organization 
commonly used for a family background:
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Managing your list of categories 

Select the “Tags” tab.

Add a category:

Right click on the upper level category (jBrout proposes a default first category named 
“Tags”) and choose the “Add Category” option from the contextual menu. Type the 
category name and validate.

Delete a category:

Right click on the category and choose the “Delete” option from the contextual menu. 
JBrout will not delete a category that contains tags.

Managing your tags list

Add a tag to a category:

Right  click  on the category and choose the “Add Tag” option  from the contextual 
menu. Type the tag name and validate.

Move tags among categories:

Select the tag to be moved, then drag and drop it to the new category. You can also 
transfer several tags at one time. Press and hold the CTRL key,  select each tag and 
move them all to the new category.

Delete a tag:

Right click on the tag et choose the “Delete” option from the contextual menu. JBrout 
will not delete a tag if it pictures are linked to it.

Remark: The tag is not removed from your pictures.
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Tagging your pictures

Once you’ve created your list of categories and tags, you still have to link tags to your 
pictures. This could be time consuming if there is a lot of pictures yet to be tagged. 
But it has to be done only once and the result will  never be lost as the tags are 
recorded in your pictures.

Adding tags to a picture or a group of pictures:

With the mouse:

Select the pictures to be labelled with the same tag, then drag and drop the tag from 
the list to the selected pictures. You can also use several tags at one time. Press and 
hold the CTRL key, select the tags, then move them to one of the selected pictures.

JBrout records the tag in the pictures straight away. The operation can last some time 
and a progression gauge is displayed at the bottom right of the window.

With the keyboard:

The other method is to use the assisted tagging with keyboard.

Select the pictures you want to label with the same tag, and type with the keyboard 
the beginning of the tag. At once, Jbrout proposes a list of tags. Use the down and up 
keys to select the wanted tag and valid.

Removing tags from a picture or a group of pictures:

Select  the  pictures  and right  click  on one of  them,  then choose  the “Delete  tag” 
option. Choose the tag to be removed, or click on “**ALL**” to remove all the tags 
from the selected pictures.

Displaying the pictures corresponding to a tag:

Double-click on the tag.
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Displaying your picture

Double-click on the thumbnail in the list to display the full screen picture.

To display the next or previous picture, use the mouse wheel, or the “Pg up” / ”Pg 
down” keys, or the “left” / “right” keys or the “up” / “down” keys. The choice is yours.

The list of tags, the EXIF and IPTC data and the comment are displayed or hidden by 
pressing the “Inser” key.

You can select tags to add or remove from the picture on the list of tags (left click on 
the tag).

To select  or  die-select the displayed picture,  press  the space  bar.  The number  of 
selected pictures is displayed at the top left of the window.

The button   deletes the picture.  You’ll be prompted to confirm the deletion when 
you'll exit the display mode.
Caution, a picture deletion is final and cannot be undone!

The button  Puts the picture in the basket. For more details, refer to the chapter 
explaining the use of the basket.

To exit the display mode, click on any button of the mouse or press the “Escape” key.
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Operations on your pictures

The standard operations are done from the thumbnails contextual menu. For most 
operations,  several  pictures  can  be  selected  at  a  time  in  order  to  perform  the 
operation on a group of pictures.

Add to basket

Puts the picture or the selected pictures in the basket. For more details, refer to the 
chapter explaining the use of the basket.

Select this folder

Opens  the  album the  picture  belongs  to  (same as  a  double-click  directly  on  the 
album).

Select this time period

Opens the “Period” tab while going to the month and the year of the picture.

Rotate right

Operates a clockwise rotation on the selected picture(s). The internal thumbnails are 
automatically rebuilt. This can also be done by clicking on the button in the toolbar.

Rotate left

Operates a anti-clockwise rotation on the selected picture(s). The internal thumbnails 
are  automatically  rebuilt.  This  can also  be done by clicking  on  the  button in  the 
toolbar.

Rebuild thumbnail

Rebuilds the internal JPEG thumbnail(s) of the selected picture(s). This functionality is 
very useful for pictures that don’t seem to have a valid EXIF thumbnail.
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Open in explorer

Opens the folder of the picture in the files browser.

Comment

Opens a window for typing the comment, that is then saved in the JPEG comment field 
of the selected picture(s).

Change datetime

Opens the window for re-timestamping the selected picture(s). One can type a gap to 
be applied to the current date and time of  the selected picture(s).  This allows to 
adjust the date and time of several pictures with one operation (this is useful when 
you have forgotten to set the date and time of your camera).
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Delete tag

Refer to the “Tag your photos” chapter.

Delete

Deletes the selected picture(s) from the disk and remove them from jBrout. You’ll be 
prompted to confirm the deletion.
Caution, a picture deletion is final and cannot be undone!
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Searching for pictures

Press the  button from the toolbar to display the search window.

• Left click on a tag to include in the search the pictures with this tag. A left click 
on a category name selects all the tags belonging to the category.

• Right click on a tag to exclude from the search the pictures with this tag. A right 
click on a category name selects all the tags belonging to the category.

• The  “from...”  and  “To...”  gauges  show  the  range  of  the  search  among  the 
pictures capture dates.

• The  “Photo  comment”  field  allows  you  to  specify  a  word  from the  pictures 
comment field as a search criterion.

• The “Album / Comment” field allows you to specify a word from the albums 
comment field as a search criterion.

• The “Format” criterion allows you to specify that the search should only return 
pictures in either landscape or portrait mode.

All these search criteria are optional and may be used concurrently, so they allow to 
search your pictures very accurately.
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In this example, the following pictures will be selected,

• those having the “New York” tag, but not the “Nicole Family” tag,
• and been taken between Friday 2006/20/10 and Wednesday 2006/25/10,
• and whose comment contains the word “restaurant”,
• and whose album comment contains the word “celebrates” ,
• and are in landscape mode.

Using the filter

Checking the  box displays the lists of the tags and albums which the pictures 
belong to. 

Amongst  other  things,  this  makes  it  possible  to  know  the  tags  and  the  albums 
currently used by the displayed pictures. 

The tags of this list can be used to tag pictures.
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Using the basket

The basket is a virtual album in which you can deposit pictures selected from your 
albums. 

It's a simple way to group pictures. All the operations on pictures from the contextual 
menu are possible (display, export, change the date,…). 

Any change made to the pictures in the basket is immediately applied to the original 
pictures.

The basket is saved all along the work session. If you leave jBrout and come back 
there later, the basket is still there with it former content.

Adding pictures to the basket

To put a picture or a selection of pictures into the basket, do a right click on one of the 
selected pictures, then choose the “Add to basket” option.

The basket can be accessed from the albums list under the name “Basket”.

Removing pictures from the basket

Display the basket content (double-click on it in the albums list), select the pictures to 
be removed, do a right click on one of them, then choose the “Remove from basket” 
option.

Removing the basket

Do a right click on the basket and choose the option “Remove”.
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SHARING YOUR PICTURES

Exporting your pictures

jBrout offers  a whole set of tools  to export  your pictures.  They are grouped in a 
module  accessible  from  the  “Operations”  option  and  “Export  to”  option  in  the 
contextual menu.

The “Resize” field exists in every export mode. It allows to adjust the size and the 
JPEG compression ratio of the pictures to be exported:

Don't touch originals: The pictures are exported in their actual format.

Resize: Adjusts the reduction percentage to be applied to the pictures.

Max size: Allows to choose from a list the height (or the width for the pictures in 
landscape mode) in pixels to be applied to the pictures (1600, 1024, 800 or 640). 

Quality: Adjusts the JPEG ratio compression. The higher the compression ratio (i.e. 
the lower the value), the smaller the image will be on the disk. Caution, below 60, the 
picture quality begins to deteriorate visually. 

Order:  allows to  choose in  which order  the pictures  will  be displayed (in  a HTML 
gallery, PicasaWeb, Flickr and Email). 

To filesystem

Folder: Indicates the destination file. Click on the button “…” to open the file selector 
in order to select the file. 

jBrout creates a sub-folder containing the exported pictures.
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To a HTML gallery

Folder: Indicates the destination file. Click on the button “…” to open the file selector 
in order to select the file.

Template: Specifies the pattern of the gallery to be created.

• xls/album.photosite.xsl: The page is divided in two parts. The left part displays 
the thumbnails list.  The right  part  displays the picture corresponding to the 
selected thumbnail. A click on the picture opens it in full screen mode.

• xls/album.xsl:  The  page  displays  the  list  of  the  thumbnails.  A  click  on  a 
thumbnail opens the picture in full screen mode.

jBrout creates two sub-folders containing the exported pictures:

• The “img” sub-folder contains the original or reduced pictures,
• The “thumbs” sub-folder contains the pictures thumbnails.

Jbrout  also  creates  the  files  “page1.html”  and  “photos.xml”.  Double-click  on  the 
former to open the gallery in your Web browser.

To a PicasaWeb account

Uploads the pictures to a PicasaWeb account. Refer to http://picasaweb.google.com/ 
for further information.

To a Flickr account

Uploads the pictures to a Flickr account. Refer to  http://www.flickr.com for further 
information.

Via Email

SMTP address: fill in the SMTP server used to send emails (refer to your client email 
parameters). SMTP server shouldn't use authentication (usually the SMTP server of 
your Internet provider).

From email: fill in your email address.

To emails: fill in the addressees of your email. Use the semicolon, the comma or space 
to separate several addressees.

Message: The subject and the message of your email. 
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To a FTP server

FTP: The address of the FTP host server (don't put http:// in the address).

Login: Your FTP account.

Password: The password associated to your account.

Path: fill in the path on your FTP account where the pictures are to be exported.

Web share

This functionality allows you to share easily your pictures on the web (P2P principle). 
Your family and friends can look at your pictures at home, simply using their internet 
browser.

Select  the  pictures  you  want  to  share,  right  click  on  one  of  them,  choose  the 
“Operations” option, then “Web share”. The following window appears:

From then jBrout acts as a http server.

Access  to  originals:  If  this  option  is  checked,  the  picture  is  not  downsized  when 
displayed on full screen mode. Beware of loading times that can become very long.

View as albums: the albums containing the selected pictures are listed on the left side 
of the browser page.
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The user of  the remote computer  opens his  browser  and fill  in your  computer  IP 
address (http://88.122.13.56:8080 in this example. The IP address is displayed at the 
top of jBrout “Instant Web” window).

The following example shows how your pictures are displayed in the web browser (the 
use of Internet Explorer is not recommended. Prefer Firefox, Opera, Kmeleon or Safari 
for example, as they are more respectful of the HTML norms):

Just click on a picture to display it in full screen mode.
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ADVANCED FUNCTIONS

Managing plugins

A plugin makes it possible to add new functionalities to jBrout easily. 

The following functionalities are currently managed through plugins:

• Clockwise rotating
• Anti-clockwise rotating
• Opening in Explorer
• Adding comments
• Changing timestamps
• Exporting to (filesystem, HTML gallery, PicasaWeb, Flickr, email, FTP)
• Web sharing

jBrout is written under the GPL licence, and authorizes and encourages you to develop 
your own plugins. 

The news plugins must be placed into following folder (to create if required):

• GNU/Linux: /home/User/.jbrout/plugins/
• Windows: Documents and Settings/User/Application Data/jbrout/plugins/

Refer  to  the http://jbrout.python-hosting.com/wiki/DevInfo page  for  further 
information.
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Calling external tools

jBrout makes it possible to implement calls to external tools (for example, to open an 
image under Gimp). 

The calls are grouped in the tools.txt file.

jBrout saves EXIF and IPTC data contained in your pictures before calling an external 
tool and re-records them after to prevent any loss of them. 

jBrout is written under the GPL licence, and authorizes and encourages you to develop 
your own external tools calls. 

Refer  to  the http://jbrout.python-hosting.com/wiki/ExternalTools page  for  further 
information.

Editing picture with Gimp

Under GNU/Linux:

• Open jBrout and click “Calling external tools” in the “File” menu. Edit the line 
corresponding to Gimp: 

• 1|Edit with Gimp|gimp $*

Under Windows:

• Add the Gimp folder in the Windows path: right-click on “My computer” and 
click on the “Properties” option. In the “Advance” tab, click on the “environment 
variables” button. Select the “path” line and click on the “Modify” button and 
add at the end of the line: ;C:\Program Files\gimp\bin and valid.

• Open jBrout and click “Calling external tools” in the “File” menu. Edit the line 
corresponding to Gimp: 

• 1|Edit with Gimp|C:\Program Files\Gimp\bin\gimp-2.2.exe $*
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TUTORIALS

Removing red eyes with Gimp

Red eyes are a recurrent feature of cameras with an integrated flash in the lens 
optical axis (as with compact digital cameras). Here is a comparatively simple and 
efficient solution with Gimp (free pictures editing software, with a GPL licence).

Prerequisites:

• Activate the external call to Gimp (refer to the “calling external tools” chapter).
• Download this script, unzip and save it in the following folder:

• with GNU/Linux: /usr/share/gimp/2.0/scripts/
• with Windows: C:\Program Files\gimp\share\gimp\2.0\scripts

Implementation:

1. In jBrout, right-click on the picture you want to modify, then select the “Edit 
with Gimp” option from the “External tools” submenu.

2. In Gimp, select the “Select elliptical regions” tool  (E key or 
“Tools”/”Selection Tools”/”Ellipse Tools” from the menu).

3. Select the first eye red area (hold down the CTRL-key in order to select an area 
from the center of the eye).

4. Select the “Red eyes” option from the “Script-Fu”/”Photo” menu/submenu.

5. Do the same thing for the second eye, starting from point 3.

6. Save the picture (“Save” option from the “File” menu).

7. Exit Gimp (CTRL+Q).
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Resizing pictures with Gimp

Here is a solution quite simply to implement with Gimp (free pictures editing software, 
with a GPL licence)in order to crop and/or resize a picture.

Prerequisites:

• Activate the external call to Gimp (refer to the “calling external tools” chapter).

Implementation:

1. In jBrout, right-click on the picture you want to modify, then select the “Edit 
with Gimp” option from the “External tools” submenu in order to open the 
picture in Gimp.

2. In Gimp, select the “Crop”  (or Shift+C, or “Tools”/”Transform Tools”/”Crop & 
Resize” from the menu).

3. Select the whole picture: move the mouse cursor to the upper left corner 
(coordinates: 0,0), press the left button and while holding it, move the cursor 
to the down right corner, then release the button.

4. If desired, open the “Tool options” window: in the “GIMP” window, select the 
“Tool options” option from the “File”/”Dialogues” menu/submenu.

5. Click on “Keep aspect ratio” in the “Tool options” window.

6. Resize the picture.

7. Save the picture (“Save” option from the “File” menu)

8. Exit Gimp (CTRL+Q).
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